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Microsoft Word 2003 Part 2 

Text Alignment and Spacing 

There are several buttons on the Formatting Toolbar that allow you to change text 
alignment and spacing. 

 

 
 
 

 

Line Spacing 

Alignment 

 
 

 

 
Change Alignment 
 
Microsoft Word defaults to left justified (aligned) paragraphs.  This means that new 
lines automatically line up with the left margin.   
 
If you need to left align text, highlight the text with the mouse and click the Align 
Left button on the Formatting Toolbar. 
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Center Text 
 
To change the alignment of a paragraph, highlight the paragraph. 
 

 
On the Formatting Toolbar click the Center button. 
 

 
Your text is now lined up in the center of the page (along the vertical axis). 
 

 
Right Align Text 
 
To move the text so it is aligned with the right margin, highlight the text you want to 
move. 

 
On the Formatting Toolbar click the Align Right button 
 
 
Your text is now aligned to the right margin. 
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Full Justify Text 
 
To make the text stretch out so it takes up whole lines, highlight the text you want 
to move. 
 

 
 
On the Formatting toolbar click Justify. 
 

 
Your text is now fully justified (spread out) across the page.. 
 

 
 

Changing Line Spacing 
 
If you want to double space your paragraph you can do this from the Formatting 
Dialog Box. 
 
On the menu bar click Format, Paragraph. 
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Click in the arrow next to Line Spacing: Single and select the spacing that you 
want.  Click OK to save your changes. 
 

 
 
 
 
 
 
You can also change line spacing by clicking the black arrow on the Line Spacing 
button on the Formatting Toolbar. 
 

 

Then click the spacing you want.  Your text will now be double spaced. 
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Adding Numbers and Bullets to a list 

To add numbers to a list: 

 the list you want to number. From the formatting tool bar click the 
Numbering button.  

 

 

To add bullets to a list: 

 the list you want to bullet.  From the formatting toolbar, click the Bullets 

button.   

 

 

To change Bullet and Numbering Style: 

• Highlight the current list 
• Select the Format menu 
• Select Bullets and Numbering from the menu 
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Adding Page Numbers 

 
On the Menu bar click Insert, Page Numbers 
 

 
 
The Page Numbers Dialog Box will open. 
 

 
 
Click in the drop down arrow under Position to put your number at the top of the 
page or at the bottom. 
 

 
 
Click in the drop down arrow under Alignment to move the number to right, left, 
or center. Click OK to save your changes.   
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Headers and Footers

To create Headers and/or Footers: 

From the View menu, select Header and Footer. You should see a Header and 
Footer floating toolbar as well as a Header area:  

 

To create a Header, enter text or graphics into the Header area.  

Or, to insert page numbers, click on the page number button in the toolbar:  

To insert the time or date, click on the time or date button.  

To insert common header items such as file name, author name, etc., click on the 
Insert AutoText button for the pull-down menu and select the appropriate item.  

To create a Footer, click on the switch button to switch between header and 
footer.  

 

When you are finished, click on Close to exit the Header/Footer.  
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Adding a Table 
 
Tables are a great way to organize text. 
 
On the Menu bar click Table, Insert, Table 
 

 
 
The Insert Table box will open. 
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Use the arrows to select the number of columns and rows that you will need. 
 

 
 
AutoFit behavior adjusts the table’s columns and rows to accommodate the text.  
Fixed column width keeps each column equal.  AutoFit to contents means the 
column will only be as wide as the words inside it.  AutoFit to window is used 
when creating web pages.  After you make your selections click OK. 
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A table will appear on your page. 

 
 
Note:  You can also insert a table by using the Insert Table button 
located on the Standard Toolbar. Click on the button, hold the left 
mouse button down and drag to highlight the number of rows a
columns you need.  Release the mouse when ready and the table will appear in 
your document. 

nd 

 
If you need to add rows or columns to your table go to the Menu bar and click 
Table, Insert, and your selection. 
 

 
 
To delete a column or row (and any text you have typed in that row or column) 
click in the row or column you want to delete, and then click Table, Delete and 
your selection. 
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To hide the grid lines of the table click in your table, and then click Format, 
Borders and Shading. 
 

 
 
The Borders and Shading Dialog box will open.  Click None, and be sure your 
selection will Apply to: Table.  Then click OK. 
 

 
 
 
Your text will remain in place but the grid lines will disappear. 
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Adding a Border to a Page 
 
To add a decorative border to a page on the menu bar click Format, Borders and 
Shading.  
 

 
 
The Borders and Shading dialog box will open.  Click Page Border. 
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Click in the drop down arrow next to Art and select the border you want.  You 
can scroll down to see more options.  Click OK to apply your border. 
 

 
 
 
Your border will appear on the page. 
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Adding Clip Art 
 
On the menu bar click Insert, Picture, Clip Art 
 

 
 
Clip Art will open in the task pane.  Type a description of what you are looking for 
in the Search for: box and Click GO. 
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The computer will search for images that match that description. 
 

 
 
To insert an image into your document, click on the image and it will appear in your 
document wherever your cursor is. 
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To resize the image click on it to select it and then move your mouse to the 
bottom right corner so that you get a two way arrow.  Click and drag to shrink or 
expand the image. 

 
 
To center an image on the page click on the image to select it then click the 
Center Alignment button on the Formatting toolbar. Your image will move to the 
center of the page.  
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 Drawing Toolbar Features 
 
There are several features on the drawing toolbar that will allow you to add 
illustrations to your documents: 
  
 

1. AutoShapes 

2. Line Tool 

3. Arrow Tool 

4. Square Tool 

5. Circle Tool 

6. Text Box 

7. WordArt 

 

8. Diagrams & Charts 

9. Insert Clip Art 

10. Insert Picture 

11. Fill Color 

12. Line Color 

13. Text Color 

14. Line Styles 

15. Arrow Styles 

 
 

    1              2      3      4    5     6     7    8    9    10    11      12      13         14       15 

 
 
 
 
 

 

  
 

 
AutoShapes 

AutoShapes consist of various shapes, such as circles, squares, and callouts, that 

aid in illustrating points in your presentations.  To insert AutoShapes: 

 Select the Down Arrow next to AutoShapes.  

 Select the type of shape you need.  An area for drawing will appear for you 

to drag and drop your shape in. 

 Move your shape to the area of the slide you desire. 

 

Note:  To keep AutoShapes and text boxes together use Grouping. 
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To Group items: 
 Select the items you wish to group by holding down the CTRL key and 

clicking on the objects. 

 With the CTRL key still held down, Right-click on the group of items 

and select Grouping > Group. 
        
Note:  To change the order of items if stacked on top of each other use the Order 

feature. 

       

To Order items: 
 Select the item you wish to change the order of. 

 Select Send to Back or Bring to Front depending on your item. 

 

 
Line, Arrow, Square, & Circle Tools 
 
All of these tools work similarly: 

• Select the tool by left-clicking on the appropriate button. 

• Draw out the appropriate shape by holding down the left mouse button in 

the drawing area that appears in your document and sliding the mouse 

across the document to create your shape. 

• Release the mouse button 

when you are done. 

 

 

            

 

 

 

 

Copyright ©2005 ASCPL All Rights Reserved    MS Word 2 6/13/2006 9:48:58 AM/JS 
 18 



Text Box 
 

• Click on the text box  button on the Drawing toolbar  

• Place the pointer where you would like to put the text box.  

• Hold down the left mouse button and drag the box out to the desired width.  

• Type into text box and click outside the box when finished.  

 

Moving a Text Box 
Once you have created your text box you have the option to relocate it. 

• Click on the text box border until you see this type of border: 

 
• Once the text box is selected you can move the box by using the arrow 

keys. 

OR 

• Pass the mouse over the box until the cross shape appears. Hold down 

the left mouse button and drag your text box to its new location. 

• Release the mouse button to place the box. 

Note:  The process of moving also applies to any item created from the 

Drawing toolbar. 

 

Deleting a Text Box 
To delete a text box: 

• Right-click on the text box frame 

• Press the delete key on your keyboard. 

 
Note:  The process of deletion applies to any item created from the Drawing 

toolbar. 
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         WordArt allows you to add graphic design qualities to your text. 

• Select the WordArt button. 

• Choose a WordArt style.  Press OK. 

• Type your text into the dialog box and press OK. 

 

• Diagram/Organization Charts 

• Select the Insert Diagram  or Chart 
button.  The Diagram Gallery dialog 

box will appear. 

• Choose a diagram or organization chart 

type and press OK. 

• Reposition the new image to its desired 

position.  
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Clip Art and Pictures 
To add clip art to your document: 

• Click on the Clip Art button.  The clip art search window will appear in the 

Task Pane. 

• Type in your search term, collection 

type, and media file type (i.e. clip art, 

photographs, movies, sounds) 

• Click the Go button and your results 

will appear. 

• Click on the clip art selection that 

you want to insert into your 

document.  Generally the clip art will appear wherever your cursor is 

currently set. 

 
Note: See page 14 for alternate instructions on inserting clip art. 

 

To add pictures to your document: 

• Click the Insert Picture button.  The Insert Picture dialog box will appear. 

• Choose your picture’s location from the Look in drop down menu. 

• Click on the picture and click Insert. 
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Fill, Line, and Text Color 

 

To add color to your items you can change or add color by: 

• Filling in shapes with color 

• Adding color to text box borders 

• Changing the color of your text 

 

Fill Color 

To add fill color to shapes: 

• Click on the border of the shape 

• Click the down arrow next to the Fill Color button to select your color 

• Click the Fill Color button when you are ready to apply your color choice 

 

Yellow 
 

 

 

Line Color 

To add color to a border, such as a text box: 

• Click on the border of the shape 

• Click the down arrow next to the Line Color button to select your color 

• Click the Line Color button when you are ready to apply your color choice 

 

 

        Red border 

 

 

Text Color 

• Highlight your text and click the down arrow next to the Font Color 

• Click the Font Color button to apply your color choice 
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Line and Arrow Styles 
 
There are three line style buttons: 

 

 

• Line Style button - allows you to pick the thickness of your line 

 

• Dash Style button - allows you to pick the type of line (i.e. dotted, 

dashed) 

 
 

• Arrow Style button – allows you to select a left, right, or double-
ended arrow  

 
 

To apply these styles: 
 

•  Click on your line or arrow 
•  Click on the appropriate button 

 Choose an option from the menus that appear 
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Templates 

Templates On My Computer 
• Select New Document from the Task Pane drop down menu.  

• Under Templates, click On my computer….The Templates dialog box will 

appear with several category tabs to choose from that contain templates 

currently saved on your computer. 

• Select a template and click OK.  The template will immediately open. 

• Highlight areas of the resume and type your personal information in.  The 

formatting of the template will remain the same with your new information. 
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Downloading a template from Office Online 
• Select New Document from the Task Pane drop down menu. 

• Click on Templates on Office Online. 

• Locate on the Templates site the template you want to download.  

You can locate a template in one of three ways: 

• By entering keywords in the Search feature  
• By searching according to the Office program you want to use, or  
• By browsing through the various template categories  

The templates that match your searching or browsing appear in a list showing a 
thumbnail image of what each template looks like, along with its title, the version of 
Office it’s compatible with, and a rating that ranges from one to five stars, based on 
how others have rated it.  

If you don’t know what version of Office you have, it’s really easy to find out, and it 
works the same in all of the Office programs. So using Microsoft Word as an 
example, in Word click the Help menu, and then click About Microsoft Word. 

• When you find a template you want to download, double-click its title. A 

preview page of the template will appear.  

• Download the template by clicking Download Now. 
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Online Template Notes:  

• When you download something from Office Online for the first time, a page 

appears displaying the end user licensing agreement. If you agree to the 

terms of the agreement, click Accept.  

• The first time you download a template, a security warning might appear 

asking if you want to install and run the ActiveX control. Click Yes.  

 

• Once the ActiveX control successfully installs, a page appears with the word 

Status in bold letters telling you that the ActiveX control installed 

successfully. Go ahead, then, and click the Continue button. The ActiveX 

control downloads the template and opens it in the appropriate Office 

program.  

 

• If you have Office 2003 installed, the first time you download a template and 

it opens in its Office program, a dialog box appears telling you that links to 

additional assistance and resources are available for templates, and asking 

you if you want to automatically download and display these links. If you 

click Yes, a pane opens along the right side of the Office program.  
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